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ArcScan for ArcGIS Tutorial

IN THIS TUTORIAL
e Exercise 1: Raster tracing

e Exercise 2: Batch vectorization

ArcScan™ for ArcGIS® software has the tools you need to convert your
scanned raster images into vector-based GIS layers. This process can be
performed interactively or in an automated fashion.

The easiest way to learn how to use ArcScan is to complete the exercises in
this tutorial.

Exercise 1 shows you how to set up the raster snapping options and
environment, snap to raster cells, and trace raster cells to create line and
polygon features.

Exercise 2 teaches you how to edit a raster layer to remove unwanted cells,
apply vectorization settings, preview the vectorization, and generate features
using the batch vectorization mode.

Each of these exercises takes between 15 and 20 minutes to complete. You
have the option of working through the entire tutorial or completing each
exercise one at a time.



Exercise 1: Raster tracing

ArcScan makes it easy to create new features from
scanned raster images. This process can significantly
reduce the time it takes for you to incorporate raster data
into your vector database.

In this exercise, you will generate features from a scanned
parcel map by interactively tracing raster cells. You will
begin by starting ArcMap and loading a map document that
contains the raster dataset and two shapefiles.

Starting ArcMap
Before you can complete the tasks in this tutorial, you must

start ArcMap and load the tutorial data.

1. Double-click a shortcut installed on your desktop or use
the Programs list in your Start menu to start ArcMap.

2. Click the Open button on the Standard toolbar.

=y =y

3. Navigate to the ArcScanTrace.mxd map document in the
ArcScan directory where you installed the tutorial data
and select it (C:\ArcGIS\ArcTutor is the default
location).

4. Click Open.

Open HE
Lok in: [ £ &rcSean ] « & o B

ExerciseData
|ArcScanBatch, mizd

Filename:  [ArcScanTrace.mxd Open :l——e

j Cancel

v

Files of type:  [archap Documents [“nxcl

I~ Open as read-ony

Changing the raster layer symbology

Raster layers must be symbolized as bi-level images to use
the ArcScan tools and commands. You will change the
raster symbology from stretched to unique values.

1. Right-click the ParcelScan.img raster layer in the
ArcMap Table of Contents and click Properties from the
context menu to display the Layer Properties dialog box.

2. Click the Symbology tab on the Layer Properties dialog
box.

I Display Background Vahue: 0 as 15
Display NeData as I
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3. Inthe Show box, click the Unique Values display option. tew

. ﬁ Data Yiew
4. Click OK. 2, Layout view
Zoom Data »
Layer Properties M|
General| Source | Extent | Displey  Symbology | Fieds | Joins & ilates | Zoorm Layout »

Show:

[ Dram raster assigning a color to each value Bookmarks [l G Create...

il Toolbars » Manage. ..
[rate = ’7| |
E Table OF Contents
Spmbol | <VALUE> T Label [Count [ |7 T
(I < crer vabaes Al ather values Status Bar
-iHexdmg) " e oo Lt Trace polygons
l o o 7 | werflow Labels
[ 1 7 O

Identify Results

E Scrollbars
Addalvales | Add\Vales, Renove Defaui Calors_| Eg Rulers
:- Display NoDita & I Di’- Glides

Grid|

Data Frame Properties. .,

ok ] coce Aoy

o

When the display refreshes, you should see the trace area.
Locating the trace area

Spatial bookmarks are named extents that can be saved in
map documents. Creating a bookmark for areas that you
visit frequently will save you time. For information on how
to create and manage spatial bookmarks, see Using
ArcMap.
You will now zoom to a spatial bookmark created for this -
exercise. -
1. Click the View menu, point to Bookmarks, and click 5
Trace lines to set the current view to the edit area of the -
exercise.
2 059 %
g 060 ¢
1
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Start editing 2. Set the maximum line width value to 7. This setting will
ensure that you are able to snap to raster cells that
represent the lot boundaries.

3. Click OK.

The ArcScan extension is only active in an edit session. The
Start Editing command enables you to begin an edit session.

1. Click the Editor menu and click Start Editing to begin the
edit session.

Raster Snapping Dptions ﬂ E
General |
— Fiaster Calor
J Editor ¥ | Raster shapping occurs at foreground cells
Foreground - Backaround l:l Toggle Colors |
Stop Editing
Save £t — Raster Line Width
_ Snap to raster ingar features with a width lezs than or equal ta this
[Move. .. walue.
b awirriuirn width: |7 1-100.0
Sl e e |
" Dividen, o
N - — Raster Solid Diameter
BUFfer... Snap ta raster solid features with a diameter between these values.
% CopyParalel.. Minwidh [ Mewwicth [B
Merge...
Uniar r~Hol
T Huoles in raster features are ignored while snapping. Hole size is a
- diagonal pixel length.
g, ..
- Hole size: ID raster pizels.
More Editing Tools »
#2 Yelidate Selection,..
SOARPING. .. D_K I Cancel Apply
—_— 1
Qpkians. ..

Setting the raster snapping options

Raster snapping requires settings that influence the
behavior of the tracing. These options are set in the Raster
Snapping Options dialog box.

1. Click the Raster Snapping Options button on the
ArcScan toolbar to open the Raster Snapping dialog box.

Raster: IParceIScan.img j ‘ Bl ‘ Yeckorization
1

0
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4. Click the Editor menu and click Snapping to open the Creating line features by tracing raster cells

Snapping Environment dialog box. Now that you have set up your raster snapping

environment, you are ready to begin tracing the raster cells.

Editar = . . . .

J . ELW You will use the Vectorization Trace tool for this step.
el 1. Click the Vectorization Trace button on the ArcScan
Save Edits toolbar
o . :

e |
A Divide, ., Wectotization * o0} I |
N Guffer...
il Copy Parallel...
[MErgE. ..
Ui
L 2. Move the pointer until it snaps to the intersection of the
T —— lot boundaries and click to start tracing.
# Walidate Selection,, .

Cpkions. ..

5. Click the plus sign next to Raster to expand it.

6. Check the Centerlines and Intersection options for raster
snapping.

Intersection

Snapping Environment B
Layer | Werkex | Edge | End |
Parcellines O O O
ParcelPolygons O O O

Raster ;I

! Centerlines

[ Corner t e I
Inkersection ——————— J

-] Ends

[ D Salid LI
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3. Point the Vectorization Trace tool downward and clickto | 5. Once you have finished tracing around the lot
start creating the line feature.

boundaries, press F2 to finish the sketch.

N 0‘5’6
3 0,5' & N
: 057 3
0z £
058
0569
060 =
. . . . . . Ii I
4. Continue to point and click with the Vectorization Trace

tool to trace the exterior boundary of the lots. A line feature now represents the exterior boundaries of the

scanned parcel lots.
F: OSS : 06?
¥ 059N/ 2 ';”6‘ \
T~ 6™
Fooos7 3 -
R 8087
;058 ;i; .
¢ 05
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Creating polygon features by tracing raster cells

Now that you have successfully traced raster cells to

create line features, you will create polygon features using
the Vectorization Trace tool.

1. To get a better view of the area that will be traced, you
need to zoom to the bookmarked extent called Trace

polygons. Click the View menu, point to Bookmarks, and
click Trace polygons.

Wizt
@, pata view
& Laryouk Wigw

Zoom Data »

Zoom Layaout 3

» @ﬁ Create...
Toolbars 3

E Table Of Contents

[v status gar

Owerflow Labels

Manage. ..

Trace lines

Identify Resulks
E Scrollbars
EE Rulers
D'Y- Guides
Grid

Data Frame Properties. .,

Changing the edit target layer

You must change the edit target layer from ParcelLines to
ParcelPolygons to create polygon features when tracing.

1. Click the Target dropdown box on the Editor toolbar and
choose ParcelPolygons.

ARrcScan For ARcGIS TuToRIAL

Target: |ParcelPolygons ;I

2. Click the Vectorization Trace button on the ArcScan
toolbar.

Vectorization * 1 n|

3. Move the pointer until it snaps to the lower-left corner of
lot 061 and click to start tracing.

2 060 @
© 061 ¢
@ 062 ¢




4. Point the arrow toward the lower-right corner of the lot

6. When the cursor has returned to the starting point of the
and click to start creating the segments of the polygon

trace, press F2 to complete the polygon.
feature.
= =
: 060 = © o Ueu
¥ 061 =
Pl o
¢ 062 Co e
- Mos
- e W T T

5. Continue to trace the lot boundary in a counterclockwise
direction.

v 060 =
= 061 =

73
(0
8)]
N
13
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Finishing your edit session

Once you have finished tracing the raster cells and have
disabled the Vectorization Trace tool, you can stop editing
and complete the exercise by saving your edits.

1. Click the Editor menu and click Stop Editing.

J Editar = |

Stark Editing |

Save Edits
[Mave. .
Selits
Divide. .,
Buffer...

Y N

Copy Parallel...
IMerge...
Uniiam
Intersect
Clig..
More Editing Tools [3
#3 Yalidate Selection, ..

Snapping. ..

Oprions. ..

2. Click Yes to save your edits.

Do you wank bo save vour edits?
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In this exercise you learned how to set the raster snapping
options and environment, snap to raster cells, and trace
raster cells to create new line and polygon features. These
steps covered the main components of the raster tracing
process. The next exercise will show you how to edit a
raster layer and automatically generate features for an
entire raster layer using the batch vectorization tools.



Exercise 2: Batch vectorization

In this exercise, you will edit a scanned parcel map to
remove cells from the raster that are not in the scope of the
vectorization. Once the raster has been cleaned up, you will
generate features using the batch vectorization mode. You
will begin by starting ArcMap and loading a map document
that contains the raster dataset and two shapefiles.

Starting ArcMap and beginning editing
Before you can complete the tasks in this tutorial, you must
start ArcMap and load the tutorial data.

1. Double-click a shortcut installed on your desktop or use
the Programs list in your Start menu to start ArcMap.

2. Click the Open button on the Standard toolbar.

De=EE

3. Navigate to the ArcScanBatch.mxd map document in
the ArcScan directory where you installed the tutorial
data and select it (C:\ArcGIS\ArcTutor is the default
location).

4. Click Open.

10

Open [Z1x]
Look i | (3 rcGean R =

ExerciseData

K arcscanTrace mxd

Filename:  [arcScanBatch mxd

= +—@)

j Cancel

v

Files of pe: &schap Documents ()

I~ Open as readonly

Changing the raster layer symbology

Raster layers must be symbolized as bi-level images to use
the ArcScan tools and commands. You will change the
raster symbology from stretched to unique values.

1. Right-click the ParcelScan.img raster layer in the
ArcMap Table of Contents and click Properties from the
context menu to display the Layer Properties dialog box.

2. Click the Symbology tab on the Layer Properties dialog
box.

Value Label

N T ——
A
e

Color e | =
Tpe [hone 2 Histogiam

T Invert

I Display Background Vaue: 0 as I~
Display NaData as I

Cancel Asply

ARcScaN For ARcGIS TuToRIAL



3. Inthe Show box, click the Unique Values display option.
4. Click OK.

Symbol | CVALLIE> [ Label [ Count_
IR <all ot values> <all other values>
<Heading VALUE
[ 1
AddAlValues | Add Values. Fenove Defoui Calors |
:‘ Display MoData a I+
0K | Coneal Aoy

Locating the cleanup area

Spatial bookmarks are named extents that can be saved in
map documents. Creating a bookmark for areas that you
visit frequently will save you time. For information on how
to create and manage spatial bookmarks, see Using
ArcMap.

You will now zoom to a spatial bookmark created for this
exercise.

1. Click the View menu, point to Bookmarks, and click
Raster cleanup to set the current view to the edit area of
the exercise.

ARrcScan For ARcGIS TuToRIAL

@ Craka Wiz

E& Layouk View
Zoom Data »
Foom Layout »

Bookmarks d EB Create...
Toolbars »
E Table Of Contents

|T Skabus Bar

Cverflow Labels

Manage. ..

Cell selection

Identify Results
E Scrollbars
EF Rulers
Iq- Glides
Grid

Data Frame Propetties. .

When the display refreshes, you should see the edit area.
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Start editing

The ArcScan extension is only active in an edit session. The
Start Editing command enables you to begin an edit session.

1. Click the Editor menu and click Start Editing to begin the
edit session.

J Editor = |

Stop Editing
Save Edits
e, .
Split, ..
Divide. .
Euffer...

S N

Copy Parallel., .
Merge.. .
Ui
Intersect
Clip,..
Mare Editing Taols 3
#4 Yalidate Selection, .

Snapping. ..

Qpkians, .

12

Cleaning up the raster for vectorization

When performing batch vectorization, it is sometimes
necessary to edit the raster image prior to generating
features. This process is referred to as raster cleanup and
involves the removal of unwanted cells from the raster
image that are not in the scope of the vectorization.
ArcScan provides the tools to perform raster cleanup.

You will now use the Raster Cleanup tools to remove
unwanted text from the ParcelScan image.

1. Click the Raster Cleanup menu and click Start Cleanup
to start the raster cleanup session.

Faster Cleanup = |

T O

Stop Cleanup

a

Raster Painting Toolbar

Erase Selected Cells

Eill Selected Cells

SaveE

SaVE A5,

2. Click the Raster Cleanup menu and click Raster Painting
Toolbar to display the Raster Painting Toolbar.

Raster Cleanup |

Start Cleanup
Stop Cleanup

o

Raster Painting Toolbar

Erase Selected Cells

Eill Selected Cells

Save

Save As...
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3. Click the Erase tool located on the Raster Painting
toolbar.

Bul@ N~ = 2% %

)

4. Click and hold down the left mouse key and erase the
text located at the top of the parcel lot.

ARrcScan For ARcGIS TuToRIAL

5. Continue to erase the text with the Erase tool until it has
been completely removed from the image.

In addition to the Erase tool, the Raster Painting toolbar
supports another tool designed to erase cells. This tool is
called the Magic Erase tool, and it allows you to erase a
series of connected cells by simply clicking or dragging a
box around them.

6. Click the Magic Erase tool located on the Raster
Painting toolbar.

B @[ N = P W

o
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7. Drag a box around the text located in the center of the Using the cell selection tools to assist with raster
parcel lot to remove it. cleanup

In the previous steps, you learned how to use the Erase and
Magic Erase tools to remove unwanted cells from the
raster image. However, if the image you are working with
requires much cleanup, these techniques could be time
consuming. To help streamline this process, you can use the
cell selection tools in conjunction with the raster cleanup
tools.

1. To get a better view of the edit area, you need to zoom
to the bookmarked extent called Cell selection. Click the
View menu, point to Bookmarks, and click Cell selection.

Wigw
E Daka Wiew
. E& Layouk Wigw
The text is now removed from the raster. oo Date S

Zoom Layouk »
d EB Create. ..

Toolbars » Manage...

E Table Of Contents Raster cleanup
v status Bar

COwerflaw Labels

Identify Resulks
E Scrolbars
i Rulers
DY- Guides
Grid

Data Frame Properties...
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When the display refreshes, you should see the edit area. 3. In the Select connected cells dialog box, enter a value of

500 for the total area of raster pixels. This expression

/;\ a0 17 04 % will select all the cells that represent text in the raster.
=} !
o - .y .
g =] 00 - e 4. Click OK.
= A —
2‘«'_ us (-] o (] % Select connected cells K E
ug-’:.’“ . h"f 67 Choosze the type of connected cell selection:
fen} O O 2 i oy ITotaI area of cormected cells -
1.7.'*
an ki = 02 O w Choose where to search for connected cells:
_ g‘_s IFDreground j
'f_? O O 3 :?I‘J 100 Chooze the aperataor ta constrain how the values are
o O 2 1 :“_? Iless than j
ks 1
e MMA g Enter total area;  |500 razher pinels
. . - e Ch b th It will affect th trast
2. Click the Cell Selection menu and click Select e T e e e e
IEreate a new selection j
Connected Cells.

[~ Select only from the cument extent

Q. I Cancel |
(4

Cell Selection

ct Connected Cells. ..

Interactive Selection Target  »

B Clear Selected Cells

Save Selection As...
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The cells that represent the text in the raster are now

The selected cells are now erased.
selected.

(\ 45 [ 4204 % ( \
£d ol o
-~ A 1 - Z
¥ g |9 o g

e .
2 002 N\et—
o0 Ti 020 =
- 003 d—m

3 021 +

- nNnAaz

Using the vectorization settings
5. Click the Raster Cleanup menu and click Erase Selected

Batch vectorization relies on user-defined settings. These
Cells to delete the selected cells. settings influence the geometry of the generated features.

These settings may vary depending on the type of raster
P — data you are working with. Once you have determined the
Raster Cleanup > |

S appropriate settings for your raster, you can save them
a within the map document or to a separate file. You will use

the Vectorization Settings dialog box to apply the settings.

Stop Cleanup

ﬁ' Raster Painting Toolbar

lected Cells

1. Click the Vectorization menu and click Vectorization
Eil Selected Cells Settings to open the Vectorization Settings dialog box.
Save
Save s,
Wectorization ™

Vectorization Setkings. ..
Shows Pressiem

| Generate Features..,

Opkions. . .
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You will now modify the vectorization settings to ensure
optimal results when generating features.

2. Change the Maximum Line Width value to 10.

3. Change the Compression Tolerance value to 0.1.
4. Click Apply to update the settings.

5. Click Close.

Yectorization Settings K

[Geometical =]

Masimum Line Wik |1|D— 1-1000

¥ Compression Tolerance: |U|'|— 0001 -50.0

M Smoothingweoht  [3 1-200

[~ Gap Closure Talerance: IU— 1-1000.0
ARGl [ 01800

Huole Size: IU— 0-1000

Shyles... | Load or zave a pre-defined vectorization style
About YWectarization | Apply | Claze |

4] 5]

Intersection Solution:

o)
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Previewing the vectorization

ArcScan provides a way to preview the batch vectorization
prior to generating features. This can help you save time by
allowing you to see how the settings will affect the
vectorization. When the settings are changed, the preview
can be updated by clicking the Apply button located on the
Vectorization Settings dialog box. This design allows you to
fine-tune the vectorization settings.

1. Click the Vectorization menu and click Show Preview.

Vecktorization =

Wectorization Settings...

Generake Features, .,

options. ..

The vectorization preview is displayed in the map.

- N
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Generating features 4. Right-click the ParcelScan.img raster layer in the
ArcMap Table of Contents and click Zoom To Layer
from the Context menu to view all of the new features
that were generated.

The final step in the batch vectorization process is to
generate features. The Generate Features dialog box allows
you to select the vector layers that will store the new
features and execute the vectorization.

Copy
1. Click the Vectorization menu and click Generate * Remave
Features. Qpen Attribute Table
Joins and Relates 3

<§Q Zoom To L
Weckorization ¥ J

! @2 Zoom To Rasker Resolution

Yectarization Settings. ..

Wisible Scale Range 3
|T Shiow Preview

Selb Mata Saurce, ..

E Generate Features. .. S ——
opkians. ..
Propertiss. ..
2. Choose the ParcelLinesBatch layer. When the display refreshes, you should see the vector

features that now represent the raster cells.
3. Click OK.

Generate Features ﬂ E

Chooze the line layer to add the centerlines bo;

[~ Save the average width of each line feature to an existing field:
Jid I

¥ Generate polygons where the maximum line width setting is exceeded

Choose the polygon layer to add thzes polygons to:
I ParcelPaolygonzB atch j

™ Generate features far the cumently selected cells only

Tip: This dialog generates features from the full extent of the raster.
To generate features for a specific extent, uze the Generate Features

Inside Area tool.
ok, I Cancel
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Finishing your edit session

Once you have finished generating features, you can stop
editing and complete the exercise by saving your edits.

1. Click the Editor menu and click Stop Editing.

J Editor * |

Start Editing

Save Edits

o) 7=
Split..,
.// Diwide. .
W Euffer...
47 Copy Parallel...
Merge. ..
Ui
Interseck
Clipi..
More Editing Taols »
#% Yalidate Selection, .,

Snapping. ..

Qpkions, ..

2. Click Yes to save your edits.

Do you want o save your edits?

Mo | Cancel |
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In this exercise you learned how to use the raster cleanup
and cell selection tools to edit a raster layer, apply
vectorization settings, preview the vectorization, and
generate features. These steps covered the major
components of the batch vectorization process.

This concludes the tutorial. You have been introduced to the
most commonly used tools and commands for raster tracing
and batch vectorization. The rest of this book will present
additional information that will help you better understand
the ArcScan extension.
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